Using the GroupWise Windows client

This handout supplements the TLC workshops on GroupWise. Other GroupWise materials are available from the Technology Learning Center Web site: http://www.ccsf.edu/tlc  
Click the Handouts link, then GroupWise. Look at the list of handouts and double-click to open the one you want.
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The two GroupWise clients

You can read, send, and manage your GroupWise email/calendar using two interfaces. These two interfaces are called “clients” because they work with a server in a “client-server” configuration. Whether you choose the Web or Windows client, you are looking at the same mailbox, messages, and calendar. Actions that you take in either client will be reflected in the other—that is, deleted messages will stay deleted, the contents and arrangement of folders will look the same no matter which way you view them.
The Web client

· Use the Web client to get to your CCSF GroupWise email from a Mac, from home, or while traveling. It is available on any Internet connected computer equipped with the Internet Explorer browser.

· The Web client may have all the features you need for everyday use. You must use it for looking at your mail from home or on the road. The Windows program is only available from inside the CCSF network.

1. Open the Internet Explorer browser on your Windows machine. 
2. Enter the address http://gww.ccsf.edu in the browser’s address box. 
Choose a server and login.
The Windows client
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Only available on CCSF-configured rollout machines. Access it through its desktop icon, from the Start menu,  or by clicking 
Start ( All Programs ( GroupWise ( GroupWise. 
The Windows client gives you more options than the Web client:

· Search for messages in all or selected folders

· Sort messages and folders

· Change the position of folders

· Schedule appointments to recur at regular intervals or on specific days
· Print different calendar formats
· Archive messages to your hard disk

· Configure your GroupWise email
Windows client: Main message screen
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When you open GroupWise, you see the contents of your inbox (Mailbox in GroupWise). In addition to the tasks listed, you can see more options when you right-click a message.
(
Important! The Icon Bar

If your icon bar (here or in any other screen) has icons but no identifying text:
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Right-click the Toolbar and choose Properties

2. Click the Show tab

3. Click the circle by Picture and text 

Use the icon bar to start a task quickly.
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Reading messages
· When you double-click a message’s subject in the Message list, this window appears. As usual with GroupWise screens, it pops up in front of the main window. To close it, click the Close button or the top right X.
· [image: image12.png]


Perform common actions like replying or forwarding by clicking the buttons at the top or on the right. Many other options are available from the menus.

· To see the rest of a long message, use the scroll bar at the right of the message screen.
· For Reply and Delete options click the Down-arrow beneath their icons on the right. 
QuickViewing messages
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The QuickView window displays the text of messages beneath the message list as you scroll through subject lines. You can choose to have it display icons for all attachments.
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Enable and disable the QuickView windows from the View Menu, the QuickView icon, or by pressing Control-Q.

Adjust the QuickView or Attachments windows by moving the cursor —very carefully—to the line marking the top or bottom of the window until it changes to a double-headed arrow. Then drag to resize.

(
Note:  When you display a message in the QuickView window, its status changes to Read/Opened. If the sender checks its properties in Sent Items, the display will show that you have opened the message.
Opening Attachments

To open attachments in the QuickView attachments window:
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Right-click the attachment icon
· Choose Open from the pop-up menu.

The QuickView icon bar
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Quickview has its own icon bar. 

As with any GroupWise icon bar, you can change this bar to text + pictures by following these steps.

1. Right-click the Toolbar and choose Properties

2. Click the Show tab

3. Click the circle by Picture and text 

QuickView and the Calendar
Turn off QuickView when you want to look at your calendar. 
You might also want to turn off the folder display (on the menu bar, click View ( Folders List).

Composing and sending messages
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To start a new message, click the New Mail icon or press Control-M. The Mail To: window opens.
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If your icons show no text, right click one, choose Properties ( Pictures and Text.
CC : Carbon copy: Addresses in this field will also receive the message. 
BC: Blind Copy. Your message will be sent to all addresses BC field, but these addresses won’t appear to other recipients.

Addressing messages
For CCSF GroupWise addresses do one of the following:

· Use Name Completion (see next page) by starting to type a name (the fastest way) 
· Search for an address in one of the address books

· Type in a group name
For addresses outside CCSF, type in the complete email address (username + @ + ISP). Name completion may work here if the address is in one of your personal address books.

Notes on email addresses

· Your address: To the outside world, your address is your login name + ccsf.edu. So, if you log in as jdoe, your address is jdoe@ccsf.edu
· For people with CCSF GroupWise accounts, use name completion (see Name Completion on page 7) or the Address book (see page 12).

· For addresses outside CCSF, always include the full address, name @ address. For example, you might address a hotmail user as felice_p4642@hotmail.com.

Name Completion

In the Windows client, GroupWise doesn’t expect you to type in an email address: it expects you to start typing a name (first or last name first, then a space, then last or first name—however names are listed in your GroupWise Address book).

To change how names are listed (first or last name first), open your address book and on the menu bar, click View ( Name format. Click the bubble beside the format you want. Then, if you choose last name first, you can use name completion by starting to type last names; if you chose first name first, start to type first names.

When you begin typing a name in the To, CC, or BC boxes of an item you are creating, Name Completion tries to complete the name for you. It searches the address books in an order that you can specify for entries that match what you are typing.  
· You see the name, not the actual address, in the address field.
· If Name Completion finds the name you are looking for, you can stop typing. Hit Enter to type another name, or Tab to go to the next (Subject) line.

· If Name Completion doesn't find it, continue typing: Name Completion searches again after each new character you type. 

· If Name Completion finds a name that is close to but doesn't exactly match the one you are looking for, you can use the Up- or Down-arrows to scroll through adjacent names in the address book. Don’t use the Side arrows for this function!
· You can tell Name Completion to search your address books in a specific order: with address books open, on the menu bar, click File ( Name completion search order. However, Name Completion always searches the system address book last.

Saving incomplete messages

In the Windows client you can save an incomplete message at any time so that you can come back, complete and send it later. To save your message:

Close the message you are working on, or press Control-S, or, on the menu bar, 
click File ( Save Draft.
The Folders window appears, with the Work in Progress folder highlighted. Click OK to save there. 
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To get back to the message, double-click to open the Work In Progress folder and double-click the message.
Attachments
An attachment is a file (e.g. Word document, picture, Web page) that travels along with email but is not in the body of a message. Normally, attachments open in the program that created them (Word, Excel), or in a program that reads them (a browser for Web pages, an image viewer or editor for pictures).
Sending Attachments
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Start a new message: click the New Mail icon or press Control-M.
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In the new message window, click the Attach icon at the top or on the right of the window. The Attach File window opens. It allows you to browse your computer for files to attach.
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Click the down-arrow to the right of the Look in: box to see locations.
2. Click the location to open it and navigate to the document or picture that you want.

3. Click OK. The file appears as an icon below your message.

Repeat as many times as necessary until you have all your attachments. 
To delete an attachment from your list (the original file will remain on your disk):

· Click to highlight the file icon

· Press the Delete key or, from the menu bar, click  Edit ( Delete.

When you send your message, your attachments will travel with it.

(Tip: 
Don’t send very large attachments or so many files that they will clog the mail system and make you unpopular with your recipients.

Opening Attachments
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A Paperclip icon marks messages with attachments in your message list. 
When you read the message, you’ll see the attachments as icons in the bottom division of the message window. Try double-clicking the attachment. If you have a problem, right click and choose Open from the popup menu.
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On Windows computers, pictures will often open in Microsoft’s Picture Viewer. It uses icons for common actions.

You can also right-click a picture icon and choose Open with to pick the program you want to open with the image.
Saving Attachments

(so you can find them later)

When you’ve opened the attachment in a program, you can view or print it as usual. To save, on the menu bar, click File ( Save As (don’t just save). In the Save As window, you can control where you want the file to go. Click the down-arrow to the right of the Save in: box and you can choose the desktop, My Documents, a floppy or Zip.
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If you just click the Save icon or choose File ( Save, the document will most likely go to a temporary folder and you’ll never find it again.

Folders

The left side of the GroupWise window shows your email folders. Show or hide this folder display by clicking View ( Folders list from the menu bar.

[image: image30.png]Close.

[ wai |

Informatian

Save Group.




All the folders in the illustration except those inside the Cabinet are standard for all accounts. You normally create your own folders inside your Cabinet folder. 
+/-

Click the plus sign beside a folder to see folders inside that folder. Click the minus sign beside a folder to close the display of folders inside it.
To file/save a message to a folder

· Drag from the message list to the folder

· Select multiple messages by control-clicking and drag them all to a folder

Or 
1. While reading a message, click Edit ( Move/Link to Folders
2. Choose the folder
3. Click Move. (Link keeps the message in both locations—not what you usually want.)

To Sort folders

Right-click the folder you want to sort and choose Sort if available. 
If not, right-click the folder, click Properties; then click the Display tab and use the down-arrows to the right of the Sort by and Sort Order boxes to sort as you want.

To change the position of your folders

In the main screen, click Edit ( Folders on the menu bar, select the folder you want to move and use the Move buttons to reposition. 
Address books
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Your Address books
· Novell GroupWise Address Book: The address book of all people at CCSF who have a GroupWise account. After the rollout, it should include all employees. It is created at the network level. So you can’t modify entries, but you can change its display format and use it as a source for your own address book: 

· Search for individuals or  departments

· Address individual messages

· Create group or individual entries in your personal address book(s)
· Personal Address Books: Initially you have an empty address book with your name on it. Use it to include personal groups (see below) or addresses of your personal contacts, mostly outside CCSF. 
· Groups: (known in many E-Mail programs as distribution lists.) Lists of users, either internal or external to the GroupWise system. Mail can be sent to an entire group by typing the Name (Display Name) of the group in an address field.
· Novell LDAP Address book: Not in use.

· Frequent Contacts: An address book that GroupWise maintains automatically. Normally, it contains a list of people you have written to recently. You can set your own parameters for what addresses are saved.
· You can create your own address books. Open Address books and, on the menu bar, click File ( New Book. Name it, click OK, and then add entries.
Using Address Books
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When you click the Address button your address books appear.

· To use any address book, click its tab.

For CCSF addresses, most often you will start with the GroupWise Address book to:

1. Address messages to individuals or departments

2. Create groups (for committee or project mailings, for example). Groups make sending messages to frequently used lists of people more convenient.

Controlling your address books’ display format
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When you start typing an entry in an address field, GroupWise tries to complete it for you. This is called Name Completion.  

When a name displays, use the up and down arrow keys to display nearby names, or keep typing until the proper entry appears. When it does, press Enter to place the address into the active address field.

Name Completion works by having GroupWise automatically look through your address book. 

Your Address books’ display order affects how name completion will work: If first names are first, you must start to type a first name for GroupWise to complete your entry. If last names are first, you must start to type a last name. The default is First name first (so you have to type first names). To type in last names, you must change the name order.
To change the name order:

1. Open your address book and look at names in the GroupWise address book. 
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In your address book’s menu bar click View ( Name Format.
3. On the Name Format screen, click the bubble beside the format you want. 

4. Click OK. After a moment, the address book reformats.
Finding Address book entries

Open the GroupWise Address book. Start typing a name:

· Type a first or last name (depending on whether you choose to display first or last names first—see the previous section)
· Do NOT an email address or login name, unless that’s how you list some entries in your own address books.
· The cursor jumps to the first column in the search list and the highlight inside the address book entries finds the first entry starting with the letters you have typed.

· As you continue to type, the highlight moves: each letter refines the search.

· If the entry you want is highlighted, press Enter to copy it to the Address field selected in the right pane.

To search on Last name or Department:

· Sort that column: Right-click the columns and choose sort.

· Click into the column header of that field and start to type.
· The sort will be in effect for the rest of that session.

(Tip: You can select more than one entry before pressing Enter to copy all highlighted entries to an address field. If you sort on Department, you can use the normal Windows selection tools to select the entire department, and press Enter to copy all the entries to the address field selected in the right pane. 
Selection tools: Control-clicking adds entries to your selection. To add an entire contiguous group, click the first entry of the group, then Shift-click the last entry.
Using an Address Book to address mail

Mailing to Individuals

You are actually referencing your address books when you use name completion: 
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To start a new message, click the New Mail icon or press Control-M. The Mail To: window opens.

· In the new message begin to type a first name or group name in any address (To, CC, or BC) field. As soon as GroupWise finds a match, it suggests the complete name. 
· To accept the name, press Enter.
· To narrow the search, continue typing. GroupWise continues searching on each letter that you type.

· When you are close to the name you want, use the down arrow to show the next names in the system address book.

You can also open the Address book directly. 
To address an e-mail using the Address Book: 

1. Either: Start a new mail message and then click the Address button. 
Or: Click the Address book icon:
All your address books will open, identified by tab titles.
2. Click the desired address book tab.

3. Find names by starting to type a first name. The Address book automatically highlights the closest name as you type each character. Just press Enter to add the highlighted name to your email.
OR: 
Double-click names you want to add in the To field. 
4. To add names to the CC (carbon copy) or BC (blind copy) field, click the CC or BC button and double click the names you want to add.

5. Click the OK button at the bottom of the screen.

6. Type your subject and message and click Send when done.
(Note: Step #3 above is the biggest difference between what you may have been used to if you used pine. It is the biggest time-saver in this process

Mailing to Departments: Searching/Filtering
A time-saver: now you can search for whole departments. Do this in the GroupWise address book by applying a filter that displays only address book entries where Department start with the letters you specify.
For example, you can filter to display only entries where the department starts with “chem” (to isolate Chemistry department folks). You can also search on other address book fields to display items according to your criteria—perhaps, where the last name starts with “b.”
Searching/filtering doesn't actually move or delete items; it just displays certain items based on the criteria you specify. Once you turn the filter off, everything in that address book becomes visible again. 
Work with filters by opening the Address book and clicking the Filter icon to the left of the words Search List. The filter icon tells you whether or not you are filtering at the moment: 
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When the Filter icon is faded out, no filter is in effect.
· When it is yellow (as in the illustration), you have a filter operating.

To start, remove, or check on a filter, open the GroupWise address book and click the Filter icon. A menu pops up.
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· To turn filters off (to see everything), click Filter Off. The Building a Filter window opens.
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To start a new search, click Define Custom Filter.

2. Use the arrow to the left of the first box to pull down the field you want to search on. Here’s where you can choose Department.

3. The second set of arrows set the condition: the default is “Begins with”—a good choice most of the time and the safest one to start with. 
4. Type the letters that begin the department name in the second box: for example, “ast” for Astronomy, or “Fac” for Facilities planning. 
5. Click OK. The results appear in the Address Book window.
6. Select the Entries that you want:

· To select all, click Edit > Select All or press Ctrl-A

· To select multiple entries, hold down Ctrl and click the entries you want.

· On the right, click the address field where you want to add the selected names. GroupWise places the selections in that address field.

7. Or, click any address field first; then double-click any entry to send it to that field.

8. Repeat 2-7 as often as necessary to fill your address fields as you want.
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Click the Mail button at the bottom of the Address Book window to open or go back to your new email message, addressed as you have specified. 

10. If you’ll use this list of addresses again, click the Save Group button to name them. Make it short: whatever you type into the Name field of the Save Group screen is the nickname that you can enter in future messages to supply this address configuration.
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Creating Group Address Book entries

Normally, you’ll use the GroupWise address book to get the addresses of people at CCSF: you can search this book and easily choose names to form groups.

To create a group, entries for all individuals must already exist in an address book. You can’t directly type individual email addresses into a group: you must pick them from an address book.

1. Open Address books and click the tab of the book you want to take addresses from (probably the Novell GroupWise address book with CCSF’s GroupWise addresses).
2. At the top of the right pane, select the address field you want to add new names to: To, CC (Carbon Copy), or BC (Blind Copy—addresses that won’t be visible in anyone else’s mail).
3. Double click the names you want to add to your group.

4. Repeat steps 2 and 3 if you want to fill several address fields.

5. Click Save Group. The Save As Group window appears.
6. In the Save As Group window, enter a name and select an address book for the group. Whatever you type into the Name field is the nickname that you can enter in future messages to supply this address configuration.
7. Click OK 

8. Click Close
To send an email to all members of the group, either:

· Open the address book while composing a new message and double-click the group name in the address book, or 
· Simply type the group’s name (from step 6) in any address field of a new message.

Modifying an existing group

Since the address book screen is designed to allow you quickly to address a message, 
1. In the GroupWise Windows Client, open Address books and select the Address Book with the group you wish to modify.
2. Right-click the group and choose Edit. 

3. The members of the existing group will appear on the right.

4. To remove members from this group, click once on the name and click Remove.

5. To add new members to this group:

· If the person already exists in one of your address books, search the appropriate address book for the person you'd like to add. Double click the person's name. (His/her name will be added to the list in the far right window.)

· If the person does not already exist in one of your address books, click the “Add” button and follow the prompts. This creates an individual entry in your address book, which you can then add to the group.
6. When you are finished modifying the group, click the Save Group button under your new list.

7. A Save As Group dialogue box will appear.

8. To keep the Group Name click OK. Or change the Group Name or Comment here.

9. The name of the address book in which this group will be saved will appear below the Group Name. You can click the down arrow and select a different address book.

10. Click OK. 

Configuring what to save in Frequent Contacts

To see or change which addresses GroupWise automatically saves in your Frequent Contacts address book:

1. Open the Address Book window and click the Frequent Contacts tab

2. On the menu bar, click File > Properties
3. Click the Options tab

4. Make sure that Auto-saving on is selected

5. Select the types of addresses you want saved.
Note: Given the amount of spam mail on the Internet, checking items received From external sources (Internet) is probably not a good idea.

Adding incoming addresses

You can add addresses from incoming mail to your frequent contacts book.

While reading the message, right-click the From address and choose Add to Frequent Contacts from the popup menu.
Adding Individual Entries to an address book
Normally you won’t need to bother adding entries for individuals inside CCSF’s GroupWise system to your personal address book: Name Completion takes the place of such entries.
But for contacts outside CCSF’s GroupWise mail, you can easily add entries to any personal address book 
( Note: You can’t add to or delete from the GroupWise address book. It is maintained by GroupWise administrators.
1. Open Address books and click the tab of a personal Address Book. 
These buttons appear at the bottom of the window.
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2. Click Add to add an entry
3. The New Entry type window appears with person selected. Click OK
4. Enter information.
When you enter the first and last name, notice that the Display Name field gets filled in automatically. These are the fields you are most likely to search on, so it’s important that you fill them. You must fill in the E-mail address field. All other fields are optional.
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5. When you’ve entered what you want, click OK.
Now, when you start to type a first name in the address field of a new message, the name completion feature will pull up and suggest the first names in your address book before it goes to the comprehensive GroupWise address book.

Changing an individual entry

Click to highlight the entry, and click the Information button at the bottom of the window. Make your changes and click OK.

Deleting Address book entries

Highlight an entry, press the Del/Delete key, and confirm.[image: image6.png]
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Icon bar





Below main screen: QuickView area: Displays text of currently highlighted message (if QuickViewer is activated on View menu). To turn QuickView on/off, on the menu bar, click View ( Quickviewer.





Print your calendar in a choice of formats





Open in Microsoft’s picture editor





Save





Print





Standard folders:


Mailbox: Inbox (many views available)


Task list: Shows task messages. A Task is a message type that appears in recipient’s calendars with a start and due date. �A Posted task only appears in your own calendar.


Sent Items: Holds copies of all messages that you have sent. Check Properties of messages to see who has received, opened, and for Calendar-related messages, accepted or declined. Click File ( Properties or right-click a message and choose Properties. Messages are not automatically deleted: you must clean up this folder.


Work In Progress: Holds incomplete, postponed messages for you to continue and send at you leisure. To save an incomplete message, click the Save icon, or press Control-S, or close and click Yes when asked if you want to save.


Cabinet: Your personal file area. Create new folders here. Right-click Cabinet, choose new ( personal folder, and type a name, or on the menu bar, click  File ( New ( Folder. You can also create folders inside your folders by right-clicking.


Documents: Procedures for Document archiving have not been set. Stay tuned!


Trash: Deleted messages automatically go to the Trash. Messages automatically delete from the Trash after 7 days. Empty the Trash manually by right-clicking, or open the Trash and read, delete, or restore individual or groups of messages. 





Find text in messages in all or selected folders





Compose a new message





Folder list:


Click a folder to display its message list


Right-click Cabinet  and click New folder to create a new folder


Right-click Cabinet folders to delete/rename


Click Edit  > Folders to change order


Right-click a folder and click �Properties > Display tab to sort messages





Message list:


Double-click to open and read


Click to select a message


Control-click to select several


Drag to a folder to save


Drag to Trash to delete


Right-click for other options








Open Address books to:


Address a message


Add individual or group





Messages in folder





Create a new appointment or task�(special message types that create entries in recipients’ calendars)





Open address book





Attachment area: shows attached file icons





Set priority, tracking options





Open attachment dialog





Change to appointment, task, note or phone message





Open the formatting toolbar





Message area





User-created folders





Click to add more search conditions





Choices window also shows current state of filters.


To start a new search, click Define Custom Filter


To see everything, make sure to click Filter Off.





Click to choose save location











Click to browse to other folders or disks








The QuickView Window





QuickView Attachments Window





Delete selected message





Display or hide attachment window





Open previous/next message





Forward





Reply





Find text in message





Message properties





Print





Save message to disk as Word doc









